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INTRODUCTION

WHY ANOTHER LIGHTROOM BOOK?

Lightroom Classic has been around for many years, and countless
books and tutorials have been written about it. So, you might reason-
ably ask, why another one? The answer is simple: Lightroom has
changed, and so have its users .

This is especially true since the first edition of this book was published.
Over recent years, Adobe has added new tools, reworked the Develop
Module, and wholly transformed how local adjustments are made. At
the same time, many photographers, especially those who are self-
taught or returning to photography later in life, are finding the learning
curve steeper than ever .

This book is designed to make using Lightroom clear and easy to
understand. It’s not a traditional manual. Instead, it provides practical
explanations, step-by-step guidance, and examples that demonstrate
how and why you might use each feature .

If you’ve ever felt overwhelmed by sliders, unsure about what order to
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edit in, or simply want a more structured way to work, this book is
for you .

WHO THIS BOOK IS FOR

This book is written for photographers who want to get the best from
their photography without wading through software jargon or dense
technical manuals. Instead, you'll get straight, practical explanations,
focused on helping you better use Lightroom to edit photography, not
just operate software .

LIGHTROOM VERSIONS AND COMPATIBILITY

This book is written for Adobe Lightroom Classic, the desktop-based
version that forms part of the Adobe Creative Cloud Photography Plan.
It is not intended for Lightroom (formerly called Lightroom CC), the
cloud-based version of Lightroom with a simplified interface .

All chapters are based on the latest version of Lightroom Classic at the
time of writing (Autumn 2025). However, if you’re using a version
from the past couple of years, you should still be able to follow along
easily .

I also expect you to be able to follow along with later versions of
Lightroom. Adobe makes frequent releases of Lightroom. Whilst these
may add and update features, they seldom remove them. In these situa-
tions, most of the information in this book will remain applicable .

Tip: To check your version, go to Help > System Info inside
Lightroom Classic .

If you’re using a much older version of Lightroom (e.g. Lightroom 6 or
earlier), many tools covered in this book will not be available. In those
instances, you should refer to the first edition of this book .

INTRODUCTION
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HOW TO USE THIS BOOK

This book is designed to be used at your own pace and in your own
way. You can read it from cover to cover, or dip into the chapters most
relevant to your needs. You will also find the chapters arranged into
sections, and these also stand on their own .

In this book, you will find :

Clear explanations  of the Panels and Tools in the Develop
Module .
Practical examples  to help you understand what you’ve
learned .
Tips that highlight important concepts or hidden features .
Screenshots throughout .

If you’re new to Lightroom, the early chapters will give you a strong
introduction. If you’re more experienced, I recommend skim-reading
these at a minimum .

Importantly, this is a book to read with Lightroom open on your
computer. You’ll get the most benefit by trying the tools and adjust-
ments as you learn about them .

ASSUMPTIONS AND EXPECTATIONS

This book assumes you have already installed Lightroom and have
some basic experience using a computer and a mouse. It doesn’t
assume you’re comfortable with Lightroom .

Where necessary, technical terms will be explained in clear, everyday
language, and technical ideas will be introduced gradually and with
context .

This book also assumes that you care about your photography, not
just technically, but creatively. You want to improve your images
without relying on other people’s settings, presets or using guess-

INTRODUCTION
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work. You want control, confidence, and results you’re proud to share
or print .

HOW THE BOOK IS STRUCTURED

The book is divided into five Sections, each focusing on a key stage of
the Lightroom editing experience :

1. Getting Started  – Covers Lightroom basics, the Lightroom
Catalog, image importing, and some image management .

2. Understanding the Interface  – Explains how to navigate the
Develop Module and interpret previews and panels .

3. The Develop Module  – Each tool and panel is explained in
detail, with examples and workflow tips .

4. Local Adjustments & Selections  – A complete guide to
masking, selections, and targeted edits using Lightroom’s
latest tools .

5. Workflow – Teaches you how to build a consistent editing
workflow, followed by a final chapter on exporting your
finished images .

Then, at the end of the book, you will find a curated list of Lightroom
videos from my YouTube channel. These have been selected to rein-
force information in this book, provide additional information and
demonstrate creative ideas like using Lightroom to turn a daytime
scene into an atmospheric nighttime image .

The book’s structure is designed to be read sequentially, at least the
first time. After that, it allows you the freedom to jump directly to
topics that match your current needs .

LEGAL, LANGUAGE, AND SOFTWARE NOTES

Throughout this book, I’ve done my best to ensure that the instructions
are easy to follow, whether you’re using a Windows PC or a Mac.

INTRODUCTION
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Where there are differences between the two versions, for example, in
keyboard shortcuts or menu locations, I’ve explained both .

Spelling follows British English conventions (e.g. “colour” rather than
“color”), but Lightroom itself may use the American spelling. Where
this is the case, the Lightroom spelling is used .

All screenshots are based on the Mac version of Adobe Lightroom
Classic, not the cloud-based version, commonly referred to as simply
“Lightroom.” Adobe, Lightroom, Photoshop, and other referenced
names are trademarks of Adobe Systems Incorporated. This book is an
independent guide and is not affiliated with or endorsed by Adobe .

Where products are mentioned, this is purely for educational context
and not as a recommendation or endorsement. All trademarks and
copyrights are acknowledged and respected .

WHAT’S NOT COVERED

One significant area not covered in this book is photo printing. That
might seem surprising given how important printing is to photography,
but it’s intentional .

Printing involves an entirely different set of skills, knowledge and
considerations: colour profiles, soft proofing, paper types, output
sharpening, and more. These topics are complex enough to deserve a
book or course of their own. Including them here would only dilute the
clarity of the editing guidance .

I also offer separate resources, including books and video training, that
are updated regularly. You’ll find more information on these at
https://lenscraft.co.uk , where you can also sign up for my newsletter
and be notified about new releases .

This book focuses on mastering your photo editing within Lightroom.
With that foundation in place, you’ll be better prepared to produce
high-quality output, whether that’s for screen, sharing, or printing, in
the future .

INTRODUCTION

19



PRACTICE FILES

The practice files for this book can be downloaded from my Lenscraft
website on the Practice Files page. Please use the link: https:// lenscraft.
co. uk/ useful- downloads- books/

A link to download the accompanying workflow video can be found
towards the end of the book. Please do not download and watch this
video until you reach that point in the book .

INTRODUCTION
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PART ONE
GETTING STARTED

Before you begin editing your photos in Lightroom, it’s essential to
understand how the software works behind the scenes. Lightroom isn’t
like some image editors. It utilises a catalogue-based system to manage
your images, which affects everything, from where your photos are
stored to how edits are applied and saved. If you don’t understand
these basics, it’s easy to encounter problems later that could have been
avoided .

This part of the book lays the groundwork for everything that follows.
It explains what Lightroom is doing in the background, how it handles
your photo files, and how you can use this to work more efficiently
while minimising problems .

Chapter 1: Lightroom Basics for New Users starts by explaining what
Lightroom Classic is, how it differs from other photo editing software,
and what makes it unique. You’ll learn about its modular structure,
what non-destructive editing is, and why Lightroom doesn’t store your
photos. If you've ever been confused by things like where Lightroom
"puts" your images, or worried that you might accidentally lose some-
thing, this chapter will help you .



Chapter 2: The Lightroom Catalog Explained dives deeper into the
catalogue system. This is where Lightroom stores all the information
about your photos, what edits you’ve made, where the files are located,
what keywords and metadata are attached, and more. You’ll learn what
the Catalog file is, where to find it on your computer, and how to
protect it. Understanding how the Catalog works is key to avoiding lost
images, missing folders, and broken links .

Chapter 3: File Management & Image Importing brings everything
together by guiding you through the import process. You’ll learn how
to import photos into Lightroom in a controlled and predictable way,
how to set up folder structures, and how to avoid common pitfalls, like
breaking the link between Lightroom and your image files .

By the end of Part 1 of the book, you’ll have a strong grasp of how
Lightroom handles your photos, where everything lives on your
computer, and how to keep your images safe and accessible. Most
importantly, you’ll be ready to explore the editing side of Lightroom
without worrying that something is going to go wrong behind the
scenes .

MASTERING THE LIGHTROOM DEVELOP MODULE
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ONE
LIGHTROOM BASICS

FOR NEW USERS

In this chapter, you’ll gain a clear understanding of how the Lightroom
interface works, focusing on the Develop module where most of your
photo editing will take place. You don’t need to learn every feature at
once. Instead, we’ll focus on the key areas that make editing faster and
easier .

We’ll begin with an overview of Lightroom’s structure, exploring how
the different modules work together and why the Develop module is
central to your editing workflow .

UNDERSTANDING LIGHTROOM’S MODULAR
STRUCTURE

Lightroom is divided into a series of modules. Each module focuses on
a specific part of your photographic workflow. The modules can be
accessed by clicking the links at the top right of the interface .

23



The Lightroom modules

These modules are :

Library  – For organising, reviewing, and selecting your
images .
Develop  – For editing and enhancing photos .
Map  – To view images by GPS location (if your camera
supports this ).
Book  – To create photo books .
Slideshow  – To build and display image slideshows .
Print  – To prepare and print photos .
Web  – To create simple photo galleries for the web .

While all Lightroom modules serve a purpose, you’ll probably spend
most of your time in the Library and Develop modules. This book
concentrates on helping you master the Develop module .

WHAT IS THE LIGHTROOM CATALOG?

Before diving into the interface, it’s important to understand how
Lightroom works with your photos .

MASTERING THE LIGHTROOM DEVELOP MODULE
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Lightroom doesn’t store your images. Instead, it uses a special Catalog
file. This is a database that keeps track of where your photos are stored
on your hard drive and what edits you've made to them. Think of the
Catalog as a record keeper. It holds information about where your
photos are located, any changes you’ve made as well as Metadata, like
star ratings, flags, and keywords .

This database system allows Lightroom to work quickly and effi-
ciently, even with large photo libraries. The Catalog is the heart of
Lightroom and without it, Lightroom can’t function properly. Because
of this, it’s essential to maintain and protect your Lightroom Catalog
file .

NON-DESTRUCTIVE EDITING

One of Lightroom’s biggest strengths is that it’s non-destructive. When
you edit a photo, Lightroom doesn’t touch the original image file.
Instead, it saves a list of editing instructions that describe your
changes, for example, increasing brightness or changing the colour
temperature of an image .

These instructions are only applied when you export an image from
Lightroom. Additionally, they are applied to the exported copy of the
image and not the original. This means you can always go back, undo
changes, or create different versions of an image without risking
damage to the original .

THE LIBRARY MODULE: SELECTING THE RIGHT
IMAGE

Before editing an image, you’ll first select it in the Library module.
This is where you view and manage your photos, organise them into
folders or collections, and flag the ones you want to work on. Below is
an example of the Library module interface :

LIGHTROOM BASICS FOR NEW USERS
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Layout of the Library module

Here’s what you see in the screenshot :

1. Module Picker  – At the top of the screen are links to the
different Lightroom modules. The active module, in this case
Library, is highlighted .

2. Folder Panel  – On the left is a panel showing your folder
structure within the Catalog. These are the image folders that
have been imported into Lightroom. You can click these
folders to select and open them, to read their contents .

3. Thumbnail Grid – The images in the selected folder are
displayed as thumbnails in the main window. The Thumbnail
grid, as shown in the illustration, is the most useful Library
preview. But we can switch this to a Loupe Preview by
pressing E on the keyboard or double clicking a thumbnail in
the grid. The Loupe Preview displays a single image rather
than a grid of thumbnails. To switch back to the Grid view,
press G on your keyboard .

4. Filmstrip - The images in the folders also appear in a
horizontal Filmstrip along the bottom of the screen. If an
image has been selected in the grid, it will also be selected in
the Filmstrip and vice versa .

MASTERING THE LIGHTROOM DEVELOP MODULE
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To begin editing a photo, simply click on its thumbnail in the Library
module to select it. Then switch to the Develop module by clicking the
link at the top right of the interface .

THE DEVELOP MODULE: WHERE EDITING
HAPPENS

Once you are in the Develop module, you should see a preview of the
selected image, which can now be edited. Below is a screenshot
showing the layout of the Develop module .

Layout of the Develop module

Each part of the interface plays a specific role :

1. Module Picker  – As before, this lets you switch between
Lightroom modules. The selected link will appear lighter to
show that it's selected .

2. Toolbar  – Below the Histogram panel are icons for tools like
cropping, removing unwanted objects, and masking. These
tools are essential for editing and will be covered in detail
later in the book .

LIGHTROOM BASICS FOR NEW USERS
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3. Preview Area  – The central part of the screen displays a live
preview of your image. This is updated in real-time as you
apply adjustments using the tools in the Develop module .

4. Development Panels  – Down the right side of the interface
are the editing panels. These contain some of the tools you
will use to edit your photography .

5. Secondary Toolbar  – Above the Filmstrip are icons and
options for comparing images .

6. Filmstrip  – This is visible at the bottom and shows all the
images in the current folder or collection. You can use this to
quickly switch to a different photo without having to return to
the Library module. The Filmstrip can also be hidden to
maximise the preview display .

7. Management Panels – A series of panels on the left of the
interface containing features to help manage editing .

WHAT “EDITING” MEANS IN LIGHTROOM

In Lightroom, editing means adjusting the appearance of your photo.
These might include activities like correcting the exposure, changing
or enhancing colours, sharpening details, reducing noise or cropping
images to name a few. When we make edits to an image like this, we
don’t apply these changes to the original image, only to the preview.
Remember, Lightroom is a non-destructive editing tool .

The changes we apply to an image can also be grouped broadly under
two headings :

1. Global Adjustments – These affect the entire image .
2. Local Adjustments  – Affect only selected areas of an image .

Usually, both types of adjustment are required to make an image look
its best .

MASTERING THE LIGHTROOM DEVELOP MODULE
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CONSISTENCY ACROSS MODULES

Lightroom’s interface is thoughtfully designed. Several elements, such
as the Filmstrip and the Module Picker, are used in multiple modules.
This consistency is intended to help you feel at home as you move
between tasks. You will also find that the different Lightroom Panels
have standard features, such as the ability to toggle their effect on and
off. When you learn how to use something in one part of Lightroom,
you will find that it also works in other areas. Keep this in mind as you
learn how to use the different features .

SUMMARY

This chapter should have given you a sense of how Lightroom is struc-
tured and how the Library and Develop modules work together. Key
points that were also covered include :

Lightroom uses a Catalog file, a type of database, to manage
your photos .
Your original files are never changed thanks to non-
destructive editing .
Most editing happens in the Develop module, which is
designed to be intuitive once you understand its layout .

In the next chapter, we’ll explore the Catalog file in more detail as it’s
a common source of problems and misunderstandings .

LIGHTROOM BASICS FOR NEW USERS
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TWO
THE LIGHTROOM

CATALOG EXPLAINED

Think of the Lightroom Catalog as a digital filing cabinet. It doesn’t
store your actual photos but instead keeps a detailed record of every-
thing related to them. This includes where they’re located on your
computer, what edits you’ve made, and any keywords or ratings you’ve
added. It even holds a preview of the image, which makes browsing
your image library much quicker .

Lightroom doesn’t touch your original photos or RAW files. Instead, it
uses this Catalog file (usually saved with the ‘.lrcat’ extension) to track
and manage your images. All the adjustments you make in Lightroom
are stored here, in the Catalog. This is how Lightroom achieves what is
known as “Non-destructive Editing ”.

So, when you hear the term “Lightroom Catalog,” remember, it’s
Lightroom’s personal database, where it records everything about your
images, including the entire editing history .

WHY IS THE CATALOG IMPORTANT?

The Lightroom Catalog plays a central role in how Lightroom works.
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It’s not just a list of your images; it’s the core of your entire editing
system. Here’s why it’s so important :

Non-destructive editing : Every change you make to an image
in the Develop module is written directly to the Catalog file,
not the photo itself. Your original file remains untouched .
Persistent : Close Lightroom, open it a week later, and all your
edits are still there, because they’re stored in the Lightroom
Catalog .
Organisation : Star ratings, flags, keywords, and Lightroom
Collections are also all stored in the Catalog file. This allows
you to organise thousands of photos without moving the actual
files. Better still, because the Catalog is a database, you can
search it to find the image or image you want in sections using
Lightroom’s tools .

In short, the Catalog allows Lightroom to be fast and flexible while
reducing the risk of making permanent mistakes. It’s the reason you
can undo a crop you applied to an image last year or sort through
hundreds of five-star images from a trip in seconds. Unfortunately, if
you don’t know about this, it can create some misconceptions .

COMMON MISCONCEPTIONS

If you’re new to Lightroom, let’s address a few common misunderstand-
ings and clear them up early. This can save you a lot of frustration later .

“Are my photos stored in Lightroom?”

No. Lightroom only stores references to your image files, not the actual
image data itself. The Lightroom Catalog knows where your photos are
saved on your hard drive, but the actual files remain outside Light-
room. This is very important because it’s easy to break the link
between the Lightroom Catalog and the image file .
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“Can I delete my original image files after
importing?”

ABSOLUTELY NOT.  If you delete the image files, they will be lost.
A preview may still show in Lightroom, but the image is gone. You
won’t be able to recover it unless you have kept a separate backup.
Also, don’t move the original files outside of Lightroom. If you use
your computer’s file browser to move or rename an image, Lightroom
will lose track of it. When this happens, you’ll see a warning symbol
and won’t be able to edit or export the image until it’s reconnected .

“Why does Lightroom say my photo is missing?”

If you move or rename a photo or folder outside of Lightroom (using
the Windows File Explorer or Mac Finder), the location in the Light-
room Catalog won’t be updated, and Lightroom won’t be able to find
the file. Lightroom doesn’t automatically track these changes; you
must make them within  Lightroom to maintain the link .

WHAT HAPPENS TO THE CATALOG DURING
IMPORT?

When you import photos into Lightroom, you're not copying them into
the program. Instead, Lightroom does three things :

1. Creates a reference  to the location of the image file on your
computer’s hard drive .

2. Generates a preview  of the image. This allows you to view
and work with the image quickly .

3. Records metadata,  such as capture date, camera settings, and
any keywords you might apply during import .

All this information is then stored in the Lightroom Catalog. It’s like
writing an entry on a detailed index card for each photo you import,
where it lives, what it looks like, and what you’ve noted about it .
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Once the import is complete, you’ll see a grid of thumbnails in the
Library module. These are previews of the imported images, not the
original files. If you move or rename the images outside Lightroom,
the Catalog won’t be able to find them, and you’ll get a “missing file”
warning .

Tip: Always move or rename files within Lightroom to avoid
breaking file links. If you break a link, the file will go missing in
Lightroom .

After importing, you’ll also notice a Folder panel on the left in the
Library module. This shows the folder structure as Lightroom sees it,
based on what you’ve imported. It may or may not reflect the structure
of folders on your computer. It’s just the parts you’ve brought into the
Catalog. You can see an example of the Folder panel in my Lightroom
Library below .

The Folders Panel in the Lightroom Library

Here we see the Folders panel on the left containing the folders I’ve
imported to Lightroom over the years. When we select one of these
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folders by clicking it, we see a grid of thumbnails for the images Light-
room thinks are in that folder. This is all being read from the Light-
room Catalog to speed up image browsing. Without these stored
previews, Lightroom would need to generate new previews each time
we select a new folder .

WORKING WITH MULTIPLE CATALOGS

Lightroom can also support the use of multiple Catalog files, but you
can only open one Catalog at a time. Each Catalog is like a separate
filing cabinet. One might contain your personal photos, while another
might contain your client work. You choose which one to open from
the commands in the File menu. Here are some examples :

New Catalog…  creates a fresh, empty Catalog. If you’ve got
into a mess with your existing Catalog and don’t have much
historic data stored, you could use this command to start
again .
Open Catalog…  lets you switch to using a different Catalog .
Open Recent  shows the most recently used Catalogs .

For most Lightroom users, one Catalog is enough; having more might
only confuse things, especially if you are trying to learn Lightroom.
Using one Catalog keeps things simple and avoids confusion. But
knowing that you can have multiple Catalogs is helpful, especially if
you work on different projects or want to archive older images .

CATALOG MANAGEMENT TIPS

Knowing how Lightroom stores and uses your Catalog helps you avoid
major headaches later. It also points to how important the Catalog is
and so you need to manage it with care. Here are a few practical tips :

Know where it lives : Your Catalog is saved as a ‘.lrcat’ file,
usually in your Pictures or Lightroom folder. The first time
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you start Lightroom, it prompts you for a location to save the
Catalog. You may have specified a location other than the
default. It’s also a good idea to keep the Lightroom Catalog on
your computer’s hard drive if there’s room. Trying to use the
Catalog on an external hard drive will probably create
performance problems .
Back it up regularly : Lightroom can prompt you to back up
your Catalog on exit. Please don’t skip this; it’s your safety
net in case something goes wrong. You can see the Catalog
Backup schedule in the Lightroom Catalog Settings. You can
also manage old backups here .
Don’t delete or rename photos outside Lightroom : Doing
so will break the links in the Catalog. Always make changes
within the Library module; they will then be reflected on your
computer .
Use the “Find Missing Files” tool : If an image goes missing,
right-click the image and choose “Find Missing Folder” or
“Locate.” Then point Lightroom to the correct location,
assuming you know where it is. You can also do the same for
imported folders by right-clicking on them in the Folders
panel .
Scan for missing files : Often, you don’t notice a file or folder
has gone missing until sometime later. It can be helpful to
periodically scan the Lightroom Catalog for missing files. In
the Library module, click the Library menu (top left of the
interface) and choose the “Find All Missing Photos” option.
Lightroom will then scan the Catalog and display a grid of
thumbnails for any missing files. You can also access this list
by clicking the “Missing Photographs” entry on the Catalog
panel .
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The Catalog panel in the Library module

Optimise the Catalog : The Catalog, like any other database
can become full of information that slows it down over time.
When we backup the Catalog using the Lightroom Backup
feature, Lightroom fixes this by optimising the Catalog. If you
find your Lightroom performance has slowed, you can
manually perform this optimisation step. In the Library
module, click the File menu and then choose the “Optimize
Catalog…” option .

SUMMARY

Understanding the Lightroom Catalog is the first step to mastering the
software .

It’s a database, not a storage container .
It keeps track of your photos, edits, and metadata .
Your original files are never altered .
Managing your photos inside Lightroom ensures nothing goes
missing .
A regular backup routine protects your work .
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Once you grasp how the Catalog works, Lightroom becomes far less
confusing .
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END OF SAMPLE
To continue please visit:

https://lenscraft.co.uk/project/mastering-the-lightroom-develop-module-book/


